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ELECTRONIC FORMS SYSTEM (EFS)
LM-4

EFS is a web-based system for completing and filing Form
LM-4 Labor Organization Annual Report.

This tutorial demonstrates basic features and functionality of
the EFS LM-4 form. It does not contain instructions for what
Information should be provided on your report.

You can download a complete set of LM-4 Instructions from
the OLMS website at:
http://www.dol.gov/olms/regs/compliance/L M-

4 Instructions AR.pdf



http://www.dol.gov/olms/regs/compliance/LM-4_Instructions_AR.pdf
http://www.dol.gov/olms/regs/compliance/LM-4_Instructions_AR.pdf
http://www.dol.gov/olms/regs/compliance/LM-4_Instructions_AR.pdf

System Requirements and Settings

To access and use the EFS, OLMS recommends you use one of
the following browsers:

*Microsoft Internet Explorer — Version 6 or higher

*Firefox — Version 3 or higher

Screen Resolution:

For optimal viewing, set your screen resolution to 1280 x 1024 or
greater. OLMS recommends that at a minimum you set your screen
resolution to 1152 x 864 to avoid horizontal scrolling.
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Accessing the System

Log into EFS using your user ID and password and the filing union’s six-digit
file number and unique union PIN.

(Please see the tutorial on how to register if you do not have a user ID or a
union PIN.)

Subsaibe to E-mail Updates O AlDOL WESA Advanced Search

™\ UNITED STATES T — E
DEPARTMENT OF LABOR AtoZIndex Site Map FAQs DOLForms AboutDOL ContactUs

DOL Home = EFS

Electronic Forms System B B Text Size

OLIS Help

Welcome to the Office of Labor Management Standards

Electronic Forms System (EFS)

Click here for a brief tutorial of the system
:IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII‘
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Registration: Sign in:
Register for an EFS User account and passwaord - Click here.
. ) ) ) User ID |mh|‘esnah
Obtain a Union Pin - Click here.
. . i . User Password Iooooooooo

If vou wish to edit your account infarmation - Click here.
File Number |E44 - I44E
Union PIN [131150

Sign In |

Forgot your password? Forgot your User |07

Frequently Acked Questions | Freedom of Information Act | Privacy & Security Statement | Disclaimers | Customer Survey | Important Web Site Notices
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Accessing the System

Select one of the options displayed on the screen.

(Please note that the only forms that you can amend in EFS are ones that were

filed using EFS.)

What would you like to do?

Hew Form

" Continue to work on forms in progress
% Start a new form
= Amend an already submitted farm

information.

The Electronic Forms System customizes the LM report with your Union's

*

0“"
Fiscal Year Selected 20117 .t
e 0‘A
Form Selected :' M-4 =] 2
* L4
Period Covered Canns?®

Eegin Date |I31_."D1_."2El11
End Date |12_."31_.-'2I311

Get Form |

i SelectLM-4 :
: fromthe :
£ dropdown :

Note: You must
change the “period
covered” dates before
obtaining the form!
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LM-4 Page 1

The EFS form looks similar to the old Adobe form. Your union information is
pre-filled.

PAGE 1
PAGE 2
ADDNL INFO

VALTDATION
SUMMARY

L 4
I‘.
.,
[ ] *
L] ’.
ave ., Validate > Subrmit Help Print
» *
L) .
n
- FORM LM-4 LABOR ORGANIZATION ANNUAL REPORT Form Approved
U.s. D rtmerd of Lab *
-3. Uepartimert ot Labor - Office of Management and
Cffice of Labor—r'-:anagement *e Budget
_ Standargls FOR USE Dﬂ“( BY LABOR ORGANIZATIONS WITH LESS THAN $10,000 IN TOTAL ANNUAL Na. 1245-0003
Washingten, i 20210 . RECEIPTS Expires: 10-31-2013
] * '
*

n °
[This report i= mandatery under P.L. 86-257, as amended. Failurvebw comply may result in criminal prosecution, fines,or civil penalties as provided by 29 U.5.C. 439 or 440.

: READ THE INSTRUCfmS CAREFULLY BEFORE FEEPARING THIS REPORT.
[ ]
u 2. PERIOﬁ'QOVERED 3.(a) AMENDED - If this is an amended report, r
For Official Use Onlv 3 |1, FILE NUMBER *, MO DAY YEAR check here:
= cgagg * (b} TERMIMNAL - If vour organization ceased to
E u & From D‘l,fD‘lJfZD‘IY.. exist and this is its terminal report, see section [T
* Through 12/31/2011 " ¥11 of the instructions and check here:
4. AFFILIATION OR ORGANIZATION MNAME 8. MAILING ADDRESS (Type in capital letters)
FACTORY WORKERS First Mame Last Name
5. DESIGNATION (Local, Lodge, etc.) &. DESIGNATION NUMBER JOHN SMITH

P.0. Box - Building and Room Number (if any)

7. UNIT NAME (if any)
PITTSEURGH REGIOMN ROOM 1A

Number and Street

1234 MAIN STREET

City

PITTSBURGH

State ZIP Code + 4
IF'A 'I 543211234

Each of the undersigned, duly authorized officers of the above labor organization, declares, under penalty of perjury and other applicable penalties of law, that all of the
information submitted in this report (including the informaticn contained in any accempanying documents) has been examined by the signatory and is, to the best of the
under=signed's knowledge and belief, true, correct, and complete. (See Section VI on penalties in the instructions.)

20. SIGNED: I IF‘RESIDENT 21. SIGNED: TREASURER

(If other title, =ee instructions) (If other title, =ee instructions)

. Telephaone I— ) Telephaone
Date: I Number: Date: Number: I




Navigation

You can easily move through the form by using the navigation links to the
left to go directly to a page or by scrolling through pages using the arrows
at the top
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FAGE1 Save Validate > — Submit Help Print
PAGE 2
ADDHNL INFO

e b FORM LM-4 LABOR ORGANIZATION ANNUAL REPORT Form Approved
VALIDATION - UEPATLMENt of Labor Office of Management and
SUMMARY Cffice of Labor-Management Budoet

Standards FOR USE ONLY BY LABOR ORGANIZATIONS WITH LESS THAN $10,000 IN TOTAL ANNUAL No. 1245-0003
Washington, DC 20210 RECEIPTS Expires: 10-31-2013

Thi= report i= mandatory under P.L. 86-257, a= amended. Failure to comply may result in criminal prosecution, fines,or civil penalties az provided by 29 U.S.C. 435 or 440.

READ THE INSTRUCTIONS CAREFULLY BEFORE PREPARING THIS REFORT.

2. PERIOD COVERED 3. (a) AMENDED - If this is an amended report, r
For Official Use Only |1 F1| E NUMBER MO DAY YEAR EEQ;EQEEEL If izati dt
(h) MIMAL - If your organization ceased to
E 5 6 From  01/07/2071 exist and this is its terminal report, see section [~
Through 12/31/2011 XII of the instructions and check here:
4. AFFILIATION OF ORGANMNIZATION MAME &. MAILING ADDRESS (Type in capital letters)
FACTORY WORKERS First Name Last Name
5. DESIGNATION (Local, Lodge, etc.) 6. DESIGNATION NUMBER JOHN SMITH

P.0. Box - Building and Room Number (if any)

7. UMIT NAME (if any)
PITTSEURGH REGIOMN ROOM 1A

Number and Street
1234 MAIN STREET
City

PITTSBURGH

State ZIP Code + 4
m 543211234
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Each of the undersigned, duly authorized officers of the above labor organization, declares, under penalty of perjury and other applicable penalties of law, that all of the
information submitted in this report (including the informaticn contained in any accempanying documents) has been examined by the signatory and is, to the best of the
under=signed's knowledge and belief, true, correct, and complete. (See Section VI on penalties in the instructions.)

20. SIGNED: I IF‘RESIDENT 21. SIGNED: TREASURER

(If other title, =ee instructions) (If other title, =ee instructions)

. Telephaone I— ) Telephaone
Date: I Number: Date; Number: I




Getting Help Within the Form

The form has several built-in help functions.

Mouse-over text that displays information on what to report or how to enter
data into a field is available on many items.

13. Enter the total payments to officers and
employees during the reporting period
(gross salaries, lost time paymante

*
"‘ *
‘O‘ 0‘
o* *
A" 0‘

- i “0
O 13. How many members did vour AN

organization have at th — ! So
— rti iod? Enter the number of members in the labor organization at *

reporung penaod: the end of the reporting period. Include all categaries of *
3 members who pay dues, Do not include nonmember %

emplovees whao make payments in lieu of dues as a ’o‘
(D condition of ermployvment under & union security provision in *
- a collective bargaining agreement., *
Q. %
*
*

@ .
I

allowances, expenses, etc.) Enter the total amount of all payments to officers and
) ) " |emplovees made by the labor organization during the
reporting period, The amount should include, for example,
gross salaries (before tax withholdings and other pawroll
Please be sure ta: deductions); losk time pay; monthly, weekly, or daily

e Enter vour union's 5-djgallowances; and disbursements for conducting official
) ] ] 1business af the labar arganization as well as disbursements
+ Report a time period of {which were essentially far the personal benefit of the
aofficer or employee.,

+ Have your union's preskrermeormeetreeresrrer—orerrerre—rsrrresrr——r




Getting Help Within the Form

Click the Help link at the top of each page to open the form
Instructions for the current page in a new window.

e N,
g .
PAGE 1 Save Validate - = Help » Print
* L4
PAGE 2 ‘. 134
COMPLETE ITEMS 9 THROUGH 13 amns® FILE NUMEER.:544-448
ADDHL THFO
e | Enter Amounts in Dollars Only - Do Not Enter Cents |
SUMMARY

9. During the reporting period did the labor

U N IT E D STAT E S Subscribe to E-mail Updates

DEPARTMENT OF LABOR E—

AtoZ | Site Map | FAQs | Forms | About DOL | Contact Us | Espaifiol
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Eﬁpi‘ Office of Labor-Management Standards E-mail This Page
chan

DOL Home > OLMS = LM-4 Instructions
10.C
':f;‘ Compliance Assistance Office of Labor-Management Standards (OLMS)

R lat: Lib -
Irem e Al <= Page 1 Additional Information and Signaturess

News Room
11.C INFORMATION ITEMS 2-18
labol  About OLMS R
shar Answer Items 9 through 18 as instructed. Select the approprizte box for those guestions requiring & "Yes” or "Na” answer; do not leave
"ag ContactUs both boxes blank. Enter a single "0" in the boxes for tems requiring a number or dollar amount i there is nothing to report.

‘ . — If the bor organization answered "Yes” to Item
reco 9. CHANGES IN CONSTITUTION AND BYLAWS OR PRACTICES/PROCEDURES — If the lzb izatl d "Yes” to Item 9
because the labor organization’s constitution and bylaws were changed during the reporting period (other than rates of dues and fees),

12.1T a dated copy of the new constitution and bylaws must either be submitted as an electronic attachment to the Form LM-4 the zbor
arga organization submits to OLMS, or the kbor constitution and bylaws to:

Office of Labor-Management Standards
If 200 Constitution Ave., NV, Room N-1519
Washington, DC 20210-0001

re
cz If the labor organization is governed by a uniform constitution and bylaws prescribed by the labor organization’s parent national or
international body, the labor organization’s parent body may file the constitution and bylaws on the labor organization’s behalf. If the
13.F parent body files a constitution and bylaws on the lbor organization’s behalf, answer Item
Grc_:lja 9 "Yes” and state that fact in Item 19 (Additional Information).
repo If Item 9 is answered "Yes” because the lgbor organization changed any of the practices/procedures listed below during the reporting

period and the practices/ proceduras are not described in the bor organization’s constitution and bylaws, the lbor organization must
file an amended Form LM-1 (Labor Organization Information Report) with s Form LM-4 to update information on file with QOLMS:

= gualfications for or restrictions on membership;

" levying assessments;

= participating in insurance or other benefit plans;




Menu ltems

The menu across the top of the form contains the following items:

Save Add Attachments ""‘ — Validate Help Print

1. Save and Calculate — Click this item to save the current page and perform all mathematical
calculations. Calculations are not performed automatically because doing so would
dramatically reduce the speed of the application. It is important to click Save and Calculate at
regular intervals when entering data in the form. If you do not save, you will be prompted to do
so when you navigate away from a page.

2. Add Attachments — Click this item to open the Add Attachments page where supplemental
information (like a constitution and bylaws or audit report) can be uploaded. The uploaded
data can then be submitted with the form.

3. Validate — Click this item to run the form validation routine, which checks the form for missing
data. Each page has its own set of validations, and you will be prompted to fix these items
before leaving the page if you wish. All validations must be satisfied before the form can be
signed and submitted.

4. Help — Click this item to take you to page-specific instructions for completing the form. You
can navigate through the instructions page by page, or download/print a copy from our
website at: http://www.dol.gov/olms/regs/compliance/LM-4 _Instructions AR.pdf

5. Print — Click this item to open a facsimile of the electronically completed LM-4. You can save
a copy of this report to your computer and share it with others who may need to prepare or
review the document. You may save a copy of the final signed report prior to submission.
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http://www.dol.gov/olms/regs/compliance/LM-4_Instructions_AR.pdf
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Additional Information

Throughout the form, there are
places where the system will
prompt you to enter additional
information. You have the option
to check a box to enter the
information later, and the
Additional Information prompt
will remain red to remind you
that you will need to enter
additional information before
submitting your report.

To go back and enter the
additional information, double-
click on the Al icon and enter the
additional information. The
prompt will turn green, indicating
that additional information has
been entered.

The Additional Information
Summary can be found in the
left navigation pane.

Additional Information - RateChange

If " "¥es " toitem 10, you must report the new rates of dues and fees in Additional Information. Please
refer to the Item 10 instructions for specific reporting reguirements.

Please Mote: Once you begin entering information, you must press SAVE or ENTER LATER button to exit the
Additional Information data entry process.

New rate is 1.45% + .02 p/hr per month 1
[ Save |
Yes o . .
No C S LELERLL Additional Information entered
u]
Yes &

o r' Tl Additional Information needs to

be entered
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Additional Information

.. Click the “ADDNL INFQ” link in the left navigation
PAGEA ., ~*" pane to display the Additional Information Summary
d K page.

0.. .®
vACTbRYIon
SUMHARY To enter any other

additional information |
required by the form

. . . L4
instructions, click the 7 G,
. . . L]
General Information link. o "o,
Save Add Attachments Validate = U " General Information Help Print
* L4
S *
19. ADDITIONAL INFORMATION SUMMARY RTINS FILE NUMBER:S

1Question 10: New rate is 1.45% + .02 p/hr per month

19. ADDITIONAL INFORMATION SUMMARY

To go to the item, click [ssssssuunnusp 1Question 10: New rate is 1.45% + .02 p/hr per month

on the blue additional
information text.




Attachments: Attaching Supplemental Data

As with the previous forms system, EFS allows you to attach data,
such as constitutions and bylaws, that may be required to be
submitted with the report.

To begin the process of adding an attachment, click the Add
Attachments link on the top menu bar.

Add Attachments

Note: While the system does not prevent them from being uploaded,
certain file formats cannot be read by our system. The following file
formats can be read.:

*Adobe PDF

*Microsoft Word

*Microsoft Excel

*Rich Text Format

*HTML

«Standard Picture formats JPEG, BMP, GIF
oText files
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Attachments: Attaching Supplemental Data

Save Add Attachments -..‘; — Validate
ATTACHMENTS
Select Type of ;L-ttau:hmentl j
Select File |

Attach File

L4
'S *
Attached Files I’ elete
L LR 0....-“"
[qun= ®u, Attachment Type <4
‘0 0‘ *
8 test.pdf 3 Bylaws and Other Attachments l’
* *
4 . L4
ay a®
Emun ' .0
\d *
* *
* *
* *
3 .
3 .
. .
3 .
. 0
Q‘ *
L4
. .
* L4
* L4
* *
* L4
* L4
* &
* L4
* &
* L4
* L4
* L4
* *
* &
0‘ .0
. R
- G
LS 4
. R
" A

Select the type of attachment you want to upload. Reviewers can view
attachments by selecting the check box to the left of the attachment
name and clicking the open link.
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Validation

There are two types of validations built into the form to help ensure that the
correct data is being entered into the form: Page Level Validations and
Form Level Validations.

Page Level Validations occur before you navigate away from a page. A
pop up message will alert you of items that must be corrected before the
form can be signed and submitted.

Message from webpage ﬂ

The items below Failed ko pass the walidation. Do wou want o correct thermn now?
riClick "ok" to correct them now or click "Cancel” to correct them later, )

Pagez: Tkem2: You musk provide an explanation For this ikem, Please consult the Form instructions if wou are unsure of what information to provide,

Cancel |

If you click OK you can correct the item before leaving the page.

If you click Cancel, you can correct the item later. You will be prompted to
make the correction during form validation.



Validation

Form Level Validations occur as a final check before the form can be
submitted. You must click the Validate link on the top menu bar.

PAGEL Save Add Attachments = Validate Help Print

PAGE 2
FILE MUMBER:544-446

ADDHNL INFO
VALIDATION |VALIDATION SUMMARY PAGE

SUMMARY 1. Pagez:Item 9: You must pravide an explanation for this item. Please consult the farm instructions if vou are unsure of what infarmation to provide.
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The system will open the Validation Summary Page containing a list of
items that must be corrected.

You can click on each item and be taken to the page where the item can
be corrected. For more information on what should be provided for these
items, consult the form instructions.
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Signing the Form

Once all of the validation items have been corrected, the form is ready to
be signed.

Message from webpage El

is Farm has passed the walidation check. Yalidations only check ba make sure data has been entered propetly in the Farm, but there could skill Be
' This Farm h d the walidation check. Yalidati I check £ ke data has b kered Iy ir Ehe F bt th Id skill b
b reporting errors in the farm. Please review the LM-4 instructions ko make sure this Form has been filled out according to the requirements,

Please click on a signature field to sign,

The signature blocks will turn red, indicating the form can be signed.

Each of the undersigned, duly authorized officers of the above labor crganization, declares, under penalty of perjury and other applicable penalties of law, that all of the
information submitted in this report (including the information contained in any accompanying documents) has been examined by the signatory and is, to the best of the
undersigned's knowledge and belief, true, correct, and complete. (See Section VI on penalties in the instructions.)

20. SIGNED: Click Here to Sign |F'RESIDENT 21. SIGNED: Click Here to Sign |TRE;'+SURER

(If other title, see instructions) (If other title, see instructions)

, Telephone I— , Telephone I—
Date: | Number: Date: I Mumber:

Note: All officers who must sign the form must have established user
accounts and must log into EFS with their account information to
sign the form.



Signing the Form

You must re-enter your password to ‘sign’ the form. By doing
S0, you are legally attesting that you are the person identified
by name in the signature block and a duly authorized officer

of the union.

President's Signature

By entering my name and password below, I attest that I am John Smith, a duly authorized officer of
the above labor arganization, and declare, under penalty of perjury and other applicable penalties of
law, that all of the information submitted in this report (including the information contained in any
attached documents) has been examined by me and is, to the best of my knowledge and belief, true,
correct, and complete.

First Name |J-::|hn

Middle Initial I

Last Name |Smith

Date |D4_."D B20M

Password |uuuu.
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Phone Number |2025551212




Signing the Form

A minimum of two signatures are required to submit the report.

Each officer will have to log in separately to sign the form.

Once the report has been signed, if any changes are made to any fields
on the form, the signatures will be removed and the form must be
validated and signed again.
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Save a Signed Copy

Click the Print item and click File> Save As to save a signed copy of the
report as a PDF to your computer. Do this before submitting the report.

: FORM LM-4 LABOR ORGANIZATION ANNUAL REPORT
andards
I dz =]
p s mar Save jr: I =3 Downloads j €| ?’ % [~
O L2010 LM-4 Fackory Workers: e
— J e
My zatlon
3 Documents the In
w — (4
- ZATION
Jesktop Hams
Q l
O 1€, efe) ‘
__ by Documents —
(@) u _
< I Code
321-
IMATIC File name: |2D1 0 Lk-4 Factony Wk ers.pdf j Save I
Save az lype: |Adnbe FDF Files [*.pdf] =] Cancel |
P

Note: You can obtain a copy of the submitted report from the Online Public
Disclosure site. Please see the next section for information on this.




Submitting the Form

Once the signatures have been applied, the form can be submitted.

Click the Submit button from the top menu bar. Once the form has been
processed (this may take a few minutes) a confirmation message will
display:

Logout
Your LM-4 Form has been successfully accepted for processing.

Your confirmation number is: 544446-441258-20110405114851
Please make a note of this number for your records.

To view your submitted LM-4 report, visit the OLMS Online Public Disclosure Room
QOLMS Online Public Disclosure Room link:
http://www.dol.gov/olms/regs/compliance/rrlo/Imrda.htm
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You can print this message by going to File=> Print, or simply copy and
paste the text from the page into an email or word processing document.

You should now be able to view your submitted report in the Online Public
Disclosure Room, by using the link shown above.




Troubleshooting

During peak filing periods, you may experience a slowdown in saving
and validating the report.

During these busy periods, you may see an error that looks like this:

QAIDOL WESA Advanced Search

~) UNITED STATES T —
DEPARTMENT OF LABOR AtoZIndex Site Map FAQs DOLForms About DOL ContactUs
DOL Home = EFS
Electronic Forms System & B3 Text Size
Logout

Error condition 1001 has occurred during the prefill processing. If this error continues to occur, please contact the OLMS Help Desk at
1-866-401-1109. Please select the Back link below to return to the schedule.

Back

Frequently Asked Questions | Freedom of Information Act | Privacy & Security Statement | Disclaimers | Customer Survey | Important Web Site Motices
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Please wait a few minutes and try again. However, if you continue to
experience the problem, please contact our technical support desk. See
the next page for information on how to get help.
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Getting Help

If you experience difficulty using EFS, please contact
OLMS Form Technical Support toll-free at:
1-866-401-1109

This PowerPoint presentation and other information regarding EFS can be

found on our website by accessing the following URL.:
http://www.dol.gov/olms/reqgs/compliance/efs/efsintro.htm

If you have additional questions or comments please contact OLMS:
E-mail OLMS at olms-public@dol.gov
or contact your local OLMS District Office



http://www.dol.gov/olms/regs/compliance/efs/efsintro.htm
mailto:olms-public@dol.gov
mailto:olms-public@dol.gov
mailto:olms-public@dol.gov
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